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Xerox® FreeFlow® Vision Connect Overview

Xerox® FreeFlow® Vision Connect is a Web-based software solution that offers real-time, at-a- 
glance visibility and control of production operations. The dashboard screen monitors, tracks, 
and benchmarks performance across printers and sites. The dashboard screen allows you to view 
each printer in more detail for access to comprehensive information, historical information, and 
provides a means of custom filtering.

For information about server requirements, software installation, and licensing, refer to the Installing Xerox® 

FreeFlow® Vision Connect Web Application.
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Key Benefits of Xerox® FreeFlow® Vision Connect

The key benefits of Xerox® FreeFlow® Vision Connect are as follows: 

• Monitor, track, and benchmark production performance across printers and sites.

• Acquire, analyze, and compare current and historical reports from various easy-to-view charts.

• Identify, measure, and track system and process efficiencies and inefficiencies.

• Generate and export productivity data.

• Manage and register license information, account information, printers, users, and impressions targets.

• Monitor tray information, ink levels, temperature, humidity, and supplies information.

• Monitor the printers at any location with Xerox® FreeFlow® Vision Connect from your mobiles.

• Receive notifications for your printers through the app.
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Xerox® FreeFlow® Vision Connect Views

In the Xerox® FreeFlow® Vision Connect website, there are three main views available to you, depending on your 
level of access: Dashboard, Analyze, and Administration views. For more information about roles and access, refer to 
User Roles and Access.

Each view has a header at the top of the screen to ensure that Xerox® FreeFlow® Vision Connect is easy to navigate. 
From the header, you can view the logged-in user, log out, change your password, or log in again. The user can also 
access the user documentation, license information, app version information, and so on.
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User Roles and Access

The initial administrator account is created during installation. An administrator can add new users via the Web 
user interface.

User roles are as follows: 

• Organization Administrator: An organization administrator has access to the entire system, as follows: 

– Dashboard screen 

– Analyze screen 

– Administration screen 

• Administrator and Manager: Both the administrator and the manager has the same access as the 
organization administrator, except for installation and subscription management.

• Operator: The operator has access to the dashboard view.

The purpose of each view is defined in the document, along with the actions that can be performed in each view.
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Components

PPrriinntteerr AAggeenntt ffoorr FFrreeeeFFllooww VViissiioonn CCoonnnneecctt

The Printer Agent for FreeFlow Vision Connect is an on-prem application installed on the Digital Front End (DFE). 
This application forwards the engine events, consumables, and job information to the cloud hosted web app. The 
Printer Agent maintains the connection between the web app and the DFE.

FFrreeeeFFllooww VViissiioonn CCoonnnneecctt DDaasshhbbooaarrdd PPoorrttaall –– CClloouudd SSeerrvveerr ffoorr VViissiioonn CCoonnnneecctt

The App Service is a service hosted on the Microsoft Azure Cloud System. The service is responsible for hosting the 
web pages that are displayed on the mobile and the desktop. The web service interacts with the Printer Agent for 
FreeFlow Vision Connect and Microsoft services using the Azure APIs.

The Progressive Web Application (PWA) cloud hosted service provides a dashboard view of devices and its events.

User can monitor and look at the details of the printer, based on the device entitlement.

The printer events and metadata are presented to the user.

The app allows users to be added to the solution.

The app authenticates the user by username and password.

Users are automatically locked out of their account after five failed attempts.

The web app shall maintain an inactivity timer to automatically end user sessions.
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Supported Printers

The following are the list of printers that support Xerox® FreeFlow® Vision Connect: 

• Xerox® Versant® 280 Press

• Xerox® Versant® 4100 Press

• Xerox® Iridesse® Production Press

• Xerox® PrimeLink® C9065/C9070 Printer

• Xerox® PrimeLink® B9100/B9110/B9125/B9136 Copier/Printer
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Supported Mobiles Devices

The following are the list of mobile devices that support Xerox® FreeFlow® Vision Connect: 

• iPhone 13

• iPhone 14 Pro

• iPhone 14+

• iPhone 14 Pro Max

• Samsung Galaxy S23

• Samsung Galaxy A34

• Google Pixel 7a

• Google Pixel 8 Pro

Xerox® FreeFlow® Vision Connect supports the following OS versions: 

• Android 12, 13, and 14

• iOS 16.7.2 and 17.1.2
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Supported Countries and Languages

Xerox® FreeFlow® Vision Connect supports the following country and displays the respective primary language for 
that country. 

BROWSER COUNTRY DISPLAY LANGUAGE 

United States English 

France International French 

Spain International Spanish 

Canada International French/English 

Italy Italian 

Germany German 

Note: If the web app does not support the browser’s primary language, then it displays in English.
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Logging In to Xerox® FreeFlow® Vision Connect

To login to the Xerox® FreeFlow® Vision Connect, follow the below steps: 

1. In your desktop, open Xerox® FreeFlow® Vision Connect webapp https://visionconnect.portal.xerox.com.

2. Click Log In.

3. Enter your email address, then click Next.

4. Enter your password, then click Log In.

SILENT LOGIN

Once you login, the Xerox® FreeFlow® Vision Connect prompts you to choose to remain logged into the app. The 
default setting is not to remain logged into the web app. If you choose to remain logged into the web app, the 
silent login will expire after 7 days of app inactivity. Any time you access the app, the web app will restart the silent 
login with 7 days expiration. The web app will automatically expire the silent login setting if you explicitly log out of 
the web app. After the silent login expires, either by inactivity or by user action, you must again authenticate to 
access the web app. Your silent login setting is unique to each device or browser combination. If you change the 
password, the silent login setting expires, and Xerox App Gallery will require you to login to access the app from one 
or all of the devices and browsers. If you are already logged into a device and browser combination when the 
password is changed, then you will be logged out and required to reauthenticate before using the web app. When 
you choose to remain logged into the app, on the current device and browser, the web app will open directly to the 
default web app screen.
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Logging Out of Xerox® FreeFlow® Vision Connect

To log out from the logged in session of Xerox® FreeFlow® Vision Connect, follow the below steps: 

1. Click on the User icon in the global header.

2. Select Log out.

The web app allows the you to purposefully end a logged in session. The web app shall maintain an inactivity timer 
to automatically end your session. The web app displays a message to you when the time to warning is reached. 
You have the ability to restart the inactivity timer from the warning message. Any user action, for example mouse 
clicks and scrolling resets the inactivity timer.
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Viewing the Software License Information

Note: If the software license is scheduled to expire within 30 days, the License Info menu item in the Help 
menu provides an indication of the impending license expiration and pertinent licensing information.

To view the Xerox® FreeFlow® Vision Connect software license information select License Info from Help menu.

The License Info screen appears. The Software License section shows the following information: 

• License

• License Status

• License Expiration Date

• Days until expiry

• Product Name

• Version

• Printers Licensed for Use
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Data Flow Diagram

1. Internet/Wi-Fi

2. Printer Agent for FreeFlow Vision Connect 

3. Xerox Production Printer

4. Xerox® FreeFlow® Vision Connect from Mobile

5. Xerox® FreeFlow® Vision Connect from Desktop

6. Xerox® FreeFlow® Vision Connect Portal

7. Cloud Server for Vision Connect

8. Application Programming Interface (API)

9. Access List

10. Xerox App Gallery Users

11. Xerox App Gallery
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Installation Process and Workflow

TENANT ONBOARDING

1. License Manager creates a new Xerox App Account on Xerox App Gallery for the new customer.

2. Xerox App Gallery sends email invite to the new customer.

3. Customer sets up the credentials after accepting the terms and conditions.

4. License Manager sets up Xerox® FreeFlow® Vision Connect entitlement for the customer.

5. Xerox App Gallery sends email notification for the Xerox® FreeFlow® Vision Connect purchase to the customer.

6. The notification is valid for 5 days.

7. You are required to verify using the notification link, then you will be added as Administrator to shift table.

8. Customer navigates to Xerox® FreeFlow® Vision Connect in Xerox App Gallery.

9. Customer navigates to the Xerox® FreeFlow® Vision Connect Web portal.

10. App detects the new customer and fetches the details from Xerox App Gallery.

11. Xerox® FreeFlow® Vision Connect setups a new Xerox® FreeFlow® Vision Connect organization, using the 
customer business name and Xerox App Gallery ID.

12. When user logs in for the first time, the user would need to accept the terms of use agreement.

13. User can see the device status based on the entitlement.

INSTALLING PRINTER AGENT FOR FREEFLOW VISION CONNECT

To access Xerox® FreeFlow® Vision Connect web application, install the Printer Agent for FreeFlow Vision Connect on 
your DFE. 

PPrreerreeqquuiissiitteess

• Microsoft Edge.

• Printing configuration report.

1. On the DFE window, click Server > Device Center > Patches, then install the patch available for your printer. 

A new icon is created for Download Printer Agent for FreeFlow Vision Connect on the DFE desktop. 

Note: Ensure that all the available patches have been installed on your DFE. If you do not see the icon, then 
contact support representative.

2. Configure the DFE with a link to the installer placed on the Windows desktop.

3. Click on the link. 

The installer begins downloading in the browser.

4. Double-click on the installer. 

Installation begins and the installer will register the Printer Agent for FreeFlow Vision Connect Service as a 
windows system service, so that it automatically runs every time the system is powered on.
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DEVICE ONBOARDING

When the installation is complete, you can do the steps below:

1. The Printer Agent for FreeFlow Vision Connect UI appears on the DFE after the installation. The user follows the 
on-screen instructions of the Printer Agent for FreeFlow Vision Connect UI.

2. Enter your DFE Administrator Credentials. 

Note: The default credentials are admin as username and either the serial number of your DFE or Fiery.1 as 
password.

3. Select Skip Proxy if the internet connection does not require a proxy server. Otherwise, enter proxy settings for 
the proxy server name and proxy port, then save the settings.

4. If the correct proxy settings are saved, the Printer Agent for FreeFlow Vision Connect will apply the proxy 
settings and restart the printer agent application.

5. The Printer Agent for FreeFlow Vision Connect displays the status to confirm that communication with the 
FreeFlow Vision Connect Cloud Server is successful.

6. Select Add from Printer Agent for FreeFlow Vision Connect UI.

7. The UI opens the default browser and redirects you to the web app for registration.

8. Initiate login at Xerox® FreeFlow® Vision Connect. 

Note: Ensure that you complete your Xerox® FreeFlow® Vision Connect account setup before logging in.

9. Select Agree Terms and Conditions.

10. Enter the target impression count per hour and printer location.

11. Select Add a Printer to complete onboarding.

NEW USER ONBOARDING

1. In your desktop, open Xerox® FreeFlow® Vision Connect webapp https://visionconnect.portal.xerox.com.

2. Log in with your manager/administrator credentials.

3. Select Add New User button.

4. After the dialog is edited, the manager/administrator selects the Save and Send Email button.

5. Xerox App Gallery sends an invitation email to the user.
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6. To create a new account for Xerox® FreeFlow® Vision Connect, click the link on the Xerox App Gallery email: 

• If the user have a Xerox App Gallery account: 

A login page appears. Enter the email and create a new password, then accept the End User Licence 
Agreement (EULA). The web-application automatically updates the Users & Shifts table to show the newly 
added user.

• If the user does not have a Xerox App Gallery account: 

On the Xerox App Gallery email, click the Create Account button. The Create Your Xerox App Account 
screen appears, and the account will be created. The Xerox App Gallery will send a verification email. The 
user clicks Verify Account, then enters their email and password. It will automatically update the Users & 
Shifts table to show the newly added user.
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Dashboard Screen Overview

The Dashboard screen displays production print performance information for all printers. The information is 
displayed in Gauge Cards and Printer Cards. For details, refer to Printer Cards and Gauge Cards.

A logged in user can perform the following actions: 

• Select a time period for which to view printer data

• View printer information on Printer Cards

• View Gauge Cards on the Dashboard page

• View printer information in tabular format and select columns to show or hide in the table

• Expand Printer Cards to view additional printer information

• Reposition Printer Cards on the dashboard

• View total impressions against the target impressions

• View details for printer faults and warnings

• Add job waste information

• Access the Analyze and Administration views

• Add users
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Filtering Printer Data

SELECTING THE TIME FRAME

To select the time frame over which you want to display printer information: 

Select the required time frame from the dropdown in the Dashboard view.

Xerox® FreeFlow® Vision Connect Software Web Application User Guide 25

Using the Xerox® FreeFlow® Vision Connect Dashboard



Gauge Cards

Gauge Cards are panels on the dashboard that summarize performance information for all printers. Each card 
shows a different type of performance information. Gauge cards are visible to all users.

The following Gauge Cards are available: 

• Printer Statuses: This Gauge Card provides a summary of printer statuses for all printers.

• Impression Rate: This Gauge Card provides a summary of the current impression rate against the target rate for 
all printers.
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Printer Cards

A Printer Card is a panel on the dashboard that displays performance information for a registered printer. Each card 
has a colored header that shows the name of the printer. For summary information, you can view Printer Cards in 
the default collapsed view, or for detailed information, you can expand the view. To view the Printer Card in the 
expanded view, refer to Viewing Detailed Information for a Printer. 

Note: You can view the Printer Card on a mobile device for all printers you have access.

In the default view, the following information is visible on each Printer Card: 

• A graphical representation of the printer

• The printer status

• A target gauge, which shows the number of impressions against the target impressions

• Current Job

• Next Job

In the expanded view, the Printer Card shows the following additional information: 

• DFE IP Address

• The Trays tab displays information about the trays, contents, and levels

• The Ink tab provides information regarding the levels of ink or toner available in the printer

• The Environmental tab includes the temperature and the humidity gauges

• The Supplies tab displays the status of supported replaceable or serviceable parts

• Submitted Jobs

• Completed Jobs

The available printer statuses are: 

• Printing

• Warming

• Idle

• Offline

• Fault

• Unknown

• Suspended

Note: If the printer name or status information does not display in full on the Printer Card, hover the mouse 
over the truncated text. When you hover over the text, the full name scrolls across the screen.

VIEWING DETAILED INFORMATION FOR A PRINTER

To view detailed information about a printer, you can expand the Printer Card.

To expand or collapse a Printer Card:
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1. From the main application menu, select the Dashboard view.

2. For the printer for which you want to view detailed information, hover the mouse pointer over any area of the 
Printer Card except the selectable areas. 

An icon composed of four outward-pointing arrows appears. This icon is the Expand icon.

3. Click the Expand icon. 

The detailed information for the printer appears.

4. To collapse an expanded Printer Card, hover the mouse pointer over any area of the Printer Card, except the 
selectable areas. 

An icon composed of four inward-pointing arrows appears. This icon is the Collapse icon.

5. Click the Collapse icon. 

The detailed information for the printer hides.

Note: This feature is also available when using the Xerox® FreeFlow® Vision Connect on the mobile device. 
For more information, refer to Expanding the Printer Card from Mobile.

REPOSITIONING PRINTER CARDS

You can change the order in which Printer Cards appear on the dashboard.

To reposition a Printer Card on the dashboard:

1. From the main application menu, select the Dashboard view.

2. To reposition a printer card, press and hold the desired Printer Card anywhere on the card.

3. Drag the Printer Card to the new location, then release the mouse pointer. 

The Printer Card remains in the new location.

Note: If you reorder the printer card in your desktop, you can able to view the new order when using the app 
on the mobile device. But you are not able to reposition the printer cards through mobile device.

ADDING JOB WASTE INFORMATION

You can add job waste information, which is the number of finished sheets of a job that are unusable.

To add the number of waste sheets for a job:

1. From the main application menu, select the Dashboard view.

2. Expand the Printer Card. For details, refer to Viewing Detailed Information for a Printer.

3. Select the Completed Jobs tab.

4. Select the required completed job, then click the plus icon. 

A text field appears.

5. In the text field, type the number of waste sheets. 

Note: Ensure that the number of waste sheets does not exceed the total number of printer sheets printed.
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To remove the waste information, click the minus icon.
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Printer Information Table

When you log in, you can view information on each printer in a tabular format. To view the table, in the bottom 
center of your screen, click the up arrow. The table slides up from the bottom of the screen. To close the table, click 
the down arrow.

SHOWING OR HIDING COLUMNS

To show or hide columns in the printer information table:

1. Log in to Xerox® FreeFlow® Vision Connect.

2. From the main application menu, select the Dashboard view.

3. To show the printer information table, on the bottom center of the Dashboard screen, click the up arrow. 

The printer information table slides up from the bottom of the screen.

4. Press and hold a table header for two seconds.

5. In the Select Columns to Show dialog box, for each column that you want to appear in the table, select the 
appropriate check box.

6. Click OK.

7. To close the printer information table, click the down arrow.
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Xerox® FreeFlow® Vision Connect From Mobile Device

The Xerox® FreeFlow® Vision Connect provides the ability to monitor printers from mobile devices. You can access 
the dashboard to view the following:

• Summary Gauge

• Printer Status

• Printer Impressions

• List of Printers

• Single Printer Details

• Expanded Printer Cards

• Submitted and Completed Jobs

• Toner/Ink and Tray Information

You can navigate the mobile app page by using Menu option or by swiping the screen up or down in the app.

ACCESSING XEROX ®  FREEFLOW ®  VISION CONNECT FROM MOBILE

You can open and access the Xerox® FreeFlow® Vision Connect from your mobile through any web browser. To 
access the application from your mobile Home screen, refer to:  

• Adding Xerox® FreeFlow® Vision Connect to the Mobile Home Screen for Android

• Adding Xerox® FreeFlow® Vision Connect to the Mobile Home Screen for iPhone

Adding Xerox® FreeFlow® Vision Connect to the Mobile Home Screen for Android

1. Open any web browser in your mobile.

2. Type https://visionconnect.portal.xerox.com/ in the mobile web browser.

3. Log in to Xerox® FreeFlow® Vision Connect using your account credentials.

4. Click on the browser Menu icon, then click Install App. 

The app gets added to the mobile Home screen.

Adding Xerox® FreeFlow® Vision Connect to the Mobile Home Screen for iPhone

1. Open any web browser in your iPhone.

2. Type https://visionconnect.portal.xerox.com/ in the mobile web browser.

3. Log in to Xerox® FreeFlow® Vision Connect using your account credentials.

4. Touch the Upload icon, near the url on the screen.

5. Swipe the screen up, then touch Add to Home Screen from the list of items displayed.

6. In the Add to Home Screen page, you can edit the app name to be displayed on your phone, then touch Add. 

The app gets added to the mobile Home screen.
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NOTIFICATION SETTINGS

Enabling Notifications for Xerox® FreeFlow® Vision Connect

You can set up to receive notifications from Xerox® FreeFlow® Vision Connect application. To enable notifications for 
Xerox® FreeFlow® Vision Connect:

1. Log in to Xerox® FreeFlow® Vision Connect from your mobile.

2. Touch the main menu in the mobile app.

3. Touch Settings.

4. To enable notifications, touch the toggle button for Push Notification.

Enabling Notifications for iOS

For Androids, notifications are enabled by default for any app. For iPhone or iOS, to enable notifications do the 
following:

1. On your iPhone Home screen, touch Settings.

2. From the list of applications select XXeerrooxx®® FFrreeeeFFllooww®® VViissiioonn CCoonnnneecctt web app, then touch Notifications.

3. To enable notifications, touch the toggle button for Allow Notifications.

Enabling Notifications for MAC Operating System (macOS)

Notifications for any app is enabled by default in Windows Operating System. To enable notifications in macOS, do 
the following:

1. Click the menu icon Apple.

2. Select System Settings. 

A new window appears with available applications in the system.

3. Click Notifications in the side menu-bar.

4. Select the Mail icon.

5. For Allow Notifications, click the toggle button.

6. Select Banners or Alerts as Mail alert style.

7. To enable the following settings, click the toggle buttons for: 

a. Show Notifications on the Lock Screen.

b. Show in Notification Center.

EXPANDING THE PRINTER CARD FROM MOBILE

The expanded printer card does not fit on the mobile display on a single screen. So there are two separate screens 
for displaying the additional printer details on mobile. One screen displays the Supplies information and the other 
displays the Jobs list. 
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• To access Supplies information, touch the Printer mimic.

• To access Jobs, touch Jobs List, then touch Submitted Jobs or Completed Jobs.

Also,  

• Swipe right-to-left from the Supplies page to navigate to the Jobs page.

• Swipe left-to-right from the Jobs page to navigate to the Supplies page.

You can close the Supplies or Jobs pages by touching the X button on the upper-right corner to the Supplies or Jobs 
page to return to the Printer Card.
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Analyzing Historical Data

ANALYZE SCREEN OVERVIEW

On the Analyze screen, you can view and analyze historical data. Only the administrators and the managers have 
access to the Analyze screen.

On the Analyze screen, you can:

• Add Chart Cards to the Analyze view 

Note: A maximum of four chart cards can be added at a time.

• View charts by printer

• Set a date and time range for data to be included in the chart

• Export data from all printers, or from a single printer

• Reposition Chart Cards

• View sections of a chart in more detail

• Configure a single chart

• Print charts

• Change the chart type for a Chart Card

• Save the chart layout view

• Remove Chart Cards

CHART CARD

Chart Card is a panel on the Analyze screen that displays historical data in chart format. The Chart Card displays a 
chart with a title, a key, and controls for the chart. After you create a chart, you can:

• Export the chart data in .csv format

• Print the chart data

• Change the settings for the chart

The following chart types are available: 

• Print Volume

• Jobs

• Timeline

• Media

Note: If there are already four charts, you can either change one of the existing charts or remove one of the 
existing charts, then add a new one
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Expanding Chart Card

To display an expanded view of the chart, you can expand the Chart Card. The new chart size is expanded to the 
size of four charts. To expand a Chart Card, click anywhere in the chart, except the selectable areas of the chart or 
the chart controls. To revert the chart to the original size, click again in the locations described to expand the chart.

VViieewwiinngg CChhaarrtt iinn MMoorree DDeettaaiill 

To obtain more information on a specific section of a chart, you can view that section in more detail. This action 
changes the time period. To view a section in more detail, click one of the selectable areas of the chart. 

Note: This feature applies to individual charts. It is not possible to apply this action to all charts as a whole.

Adding a Chart to the Analyze Screen

You can display up to four Chart Cards on the Analyze screen at one time.

To add a chart to the Analyze screen:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. On the Analyze screen, move the mouse to an empty area, then click + Add Chart. 

The Available Charts menu appears.

3. Select the required chart type. 

• Print Volume

• Jobs

• Timeline

• Media

A Chart Card for the selected chart appears on the Analyze screen.

Configuring a Chart Card

You can configure the information that you want to display on each chart, for example, the printers and time frame.

To configure a Chart Card:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Select a Chart Card. At the upper right corner of the Chart Card, click the settings icon. 

The Configure Card dialog appears. The dialog consists of options that are unique to each chart type.

3. Select the required settings.
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4. To update the chart based on your selections, click OK. 

Note: To view the data controls to which each chart has access, refer to the following table:

CHART ATTRIBUTE LIST 
TIME 
PERIOD 

SHOW OFF- 
PRINTING 
STATUS 

PRINTER DATA CONTROLS 

ALL 
PRINTER 
DATA 
COM
BINED 

PRINTER 
GROUP 
DATA 
COM
BINED 

INDI
VIDU
AL 
PRINT
ER 
DATA 

Print Volume By Total Yes Yes Yes Yes Yes 

Jobs By Total Yes Yes Yes Yes Yes 

Timeline By Printer State Yes Yes Yes Yes Yes 

Media By Printer Yes Yes Yes Yes Yes 

By Type 

Setting the Date Range and Time Frame for the Charts

You can set date range and time frame to display historical data. You can set these parameters using the date and 
time filters at the top of the Analyze screen.

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. From the calendar icons, choose a start and end date.

3. In the Time Period field, set the required time frame.

4. Click OK.

Exporting Data to .csv

You can export the data from the Chart Card using the Export Data option. To get all the job data, export at the 
top of the Analyze view. Export within the chart using the chart controls gives only the timeline data.

To export data to .csv format:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. To export data: 

• To export all the job data for the chart, click Export Data at the top of the screen.

• To export the timeline data for a chart, click the Export icon in the Chart Card.

The export data window appears.
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3. In the Date Range area at the top of the screen, select your required date range. 
The Date Range is the date or time range used for the overall export as well as the individual chart export. 

• If you choose to export data in the Chart Card, the pop-up of Export Data window confirms the date range 
used for the export which cannot be modified in this window.

4. In the Export File Format area, select the CSV format.

5. To confirm, click Export, or to cancel the export, click Cancel.

Printing a Chart Card

You can print a Chart Card.

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. At the top of the Chart Card, click the Print icon. 

The Print dialog appears.

3. To print the Chart Card, follow the prompts in the Print dialog.

Changing the Chart Type

You can change the chart type to show a different type of data on the Chart Card.

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Select a Chart Card. At the upper right corner of the Chart Card, click the chart icon. 

The Available Charts menu appears.

3. From the Available Charts menu, select a chart type. 

The Chart Card updates to show the data associated with the new chart type.

Changing and Saving the View

Repositioning Chart Cards

You can change the order in which Chart Cards appear on the Analyze screen.

To move a Chart Card to another location on the Analyze screen:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Select a Chart Card.

3. Using the mouse pointer, drag and drop the card to the new location. 

The Chart Card remains in the new location.
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Saving Chart Card Views

You can save Chart Cards, their settings, and their layout on the Analyze screen.

To save your current Chart Card view:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Create your desired view.

3. Then select the View menu.

4. Click Save.

CCrreeaattiinngg aanndd NNaammiinngg aa NNeeww SSaavveedd VViieeww

You can create a new saved view of chart cards on the Analyze screen.

To create a new saved view on the Analyze screen:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Create your desired view.

3. Then click View at the top of the screen. 

The View menu appears.

4. Select Create New from the list.

5. Enter the desired name in the field, then click OK.

RReennaammiinngg tthhee SSaavveedd VViieewwss

You can rename the saved view of chart cards on the Analyze screen.

To rename your saved view on the Analyze screen:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Click View at the top of the screen. 

The View menu appears.

3. Select Rename from the list.

4. Enter the desired name in the field, then click OK.

DDeelleettiinngg SSaavveedd VViieewwss

You can delete the saved view of chart cards on the Analyze screen.

To delete your saved view on the Analyze screen:

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.
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2. Click View at the top of the screen. 

The View menu appears.

3. Select Delete from the list. 

A pop up window appears to confirm your deletion.

4. Click Delete.

Removing a Chart Card

You can remove individual Chart Cards, as needed.

1. From the main application menu, select the Analyze view. 

The Analyze screen appears.

2. Select the Chart Card that you want to remove. At the upper right corner of the Chart Card, click the chart icon. 

The Available Charts menu appears.

3. Select Remove Chart. 

The Chart Card is removed from the Analyze view.
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Administration

ADMINISTRATION SCREEN OVERVIEW

To access the Administration screen, you are required to log in as an Administrator or Manager. On the 
Administration screen, you can manage user and shift information, printers, and system settings.

On the Administration screen, you can:

• Manage users and shifts

• Manage printers

• Manage system information

USERS AND SHIFTS

On the Users & Shifts tab, you can add new users, edit, and delete existing users.

Adding a User

An administrator can add new users. Users are classified as administrator, operator, or manager. To facilitate 
password recovery, provide an email address for each user.

To add a new user and to add the user to groups and shifts:

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Users & Shifts tab.

3. Click Add New User. 

The Add New User dialog appears.

4. In the User Name field, type the required user name.

5. To assign the user to a group, from the Select Group menu, select the required group.

6. In the Email Address field, enter the email address of a user.

7. To assign the user to a shift, from the Select Shift menu, select the required shift.

8. To edit the shift, click Edit Shifts. 
For more information, refer to Editing Shift Information.

9. In the Password fields, type the password twice. 
Ensure that the password is compliant with the minimum security standards.

10. Click Save and Send Email.

Editing User Information

1. From the main application menu, select the Administration view. 

The Administration screen appears.

42 Xerox® FreeFlow® Vision Connect Software Web Application User Guide

Administrator Functions



2. Select the Users & Shifts tab.

3. From the list of users, select a user, then click the pencil icon.

4. In the Edit User dialog box, you can change the Username, Email ID, User Group, and Shift.

5. To save your changes, click OK.

Deleting a User

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Users & Shifts tab.

3. From the list of users, select a user, then click the trash can icon.

4. To confirm the deletion, click Delete.

Adding a Shift

To add a shift:

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Users & Shifts tab.

3. Click Edit Shifts. 

The Edit Shifts dialog appears.

4. Click Add New Shift.

5. In the Shift Name field, type the required shift name.

6. In the Start Date and End Date, set the required time.

7. In the Days of Week, select the check box for the days of the week that apply to the shift.

8. To save the changes, click OK, or to cancel the changes, click Cancel.

Editing Shift Information

To edit shift information, do the following:

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Users & Shifts tab.

3. Click Edit Shifts. 

The Edit Shifts dialog appears.

4. For the shift that you want to edit, in the Actions column, click the pencil icon.
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5. Edit the information in the following fields, as needed. 

• Shift Name

• Start Date and End Date

• Days of Week

6. Click OK.

Deleting a Shift

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Users & Shifts tab.

3. Click Edit Shifts.

4. From the list of shifts, select a shift, then click the trash can icon.

5. To confirm the deletion, click Delete.

6. Click Close.

PRINTERS

On the Printers tab, you can:

• Edit printer information

• Hide printers

• Delete printers

• Suspend data collection for printers

Viewing Additional Printer Information

You can view additional printer information for each printer represented on the Printers tab.

To view additional information:

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Printers tab.

3. Hover the mouse pointer anywhere over a printer card. The following additional printer information appears: 

• Product Name

• Serial Number, if available

• DFE IP address

• Productivity Target
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Editing Printer Information

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Printers tab.

3. Hover the mouse pointer anywhere over a printer card, except for the selectable areas of the chart or the chart 
controls.

4. Click the Edit icon.

5. Make changes as needed, then click OK.

Hiding a Printer

When you hide a printer, data collection remains enabled, but the printer is hidden from the Dashboard and 
Analyze views.

To hide a printer:

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Printers tab.

3. Hover the mouse pointer anywhere over a printer card, except for the selectable areas of the chart or the chart 
controls.

4. Click the Hide icon.

5. To confirm, click Hide.

Suspending Data Collection for a Printer

When you suspend data collection for a printer, data collection is disabled, but the printer is visible in the 
Dashboard and Analyze views.

To suspend data collection for a printer:

1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Printers tab.

3. Hover the mouse pointer anywhere over a printer card, except for the selectable areas of the chart or the chart 
controls.

4. Click the Suspend icon.

5. To confirm, click Suspend.

Deleting a Printer

To delete a printer:
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1. From the main application menu, select the Administration view. 

The Administration screen appears.

2. Select the Printers tab.

3. Hover the mouse pointer over a printer card selectable area of the chart, then click the trash can icon. 

Note: Before you continue with the deletion, a message prompts you to back up all historical data.

4. To confirm the deletion, click Delete.
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Deleting Organization Account

The Xerox® FreeFlow® Vision Connect web application allows only the original organization administrator to initiate 
a request to delete the organization account. The organization account deletion request includes all available 
licenses for that organization.

1. Select Account Info from the Help menu. 

The Account Info screen appears.

2. Click Delete Account button in the screen. 

The confirmation alert pop-up message appears.

3. Then click Delete Account on the confirmation alert pop-up. 

Account deletion pop-up message appears.

4. Click Close. 

Note: If an organization account is removed by the Xerox App Gallery, then the web app deletes all the 
associated users and the printers. The Personal Identifiable Information or the Customer Identifiable 
Information related to the organization will be removed from the system after 30 days of deletion of the 
organization account.
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This chapter contains:
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General Troubleshooting

General troubleshooting includes tips and problem solving information that pertains to the overall Xerox® FreeFlow® 

Vision Connect system.

XEROX ®  FREEFLOW ®  VISION CONNECT WEB APP NOT LOADING FULLY ON DFE

PROBABLE CAUSES SOLUTIONS

Default browser is not set to Microsoft 
Edge

Set the default browser to Microsoft Edge. 
1 In the Windows run command or in Search, type Default 

apps. 
2 Open Default apps. 
3 Locate the Web browser entry and select Microsoft Edge. 
4 If Microsoft Edge is not installed in the system, install the latest 

version of either of the Web browsers. 

NOT RECEIVING NOTIFICATIONS FROM XEROX ®  FREEFLOW ®  VISION CONNECT

PROBABLE CAUSES SOLUTIONS

Notification is disabled Enable notification for Xerox® FreeFlow® Vision Connect mobile 
app:
• To enable notification in the mobile app, refer to Enabling 

Notifications for Xerox® FreeFlow® Vision Connect
• To enable notification for Operating Systems, such as macOS, 

refer to Enabling Notifications for MAC Operating System 
(macOS). 
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This appendix contains:
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Additional Resources

SECURITY RESOURCES LINKS 

Frequently Asked Security Questions https://www.xerox.com/en-us/information-security/frequently-asked- 
questions

Bulletins, Advisories, and Security 
Updates 

https://www.xerox.com/security

Security News Archive https://security.business.xerox.com/en-us/news/
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